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1. OBIJETIVO
Describir los pasos necesarios para crear y publicar servicios web que permitan acceder a los datos
vectoriales almacenados en diversos repositorios.

2. ALCANCE

Este instructivo se encuentra asociado al procedimiento Disposicion de Informacion Geogrdfica, el cual
pertenece al subproceso de Gestion Cartogrdfica dentro de la Subdireccién de Cartografia y
Geodésica. Inicia con la publicacion de los datos vectoriales y finaliza con la publicaciéon del servicio.

3. DEFINICIONES

° ArcGIS Pro: Es una aplicacion SIG de escritorio individual, es un software con funciones de
visualizacién de datos geogrdficos, andlisis avanzados y el mantenimiento de datos acreditados en
2D, 3D vy 4D.

° Base de datos espacial: Una base de datos espacial es una coleccién de elementos o datos que
permite modelar, almacenar y consultar datos alfanuméricos o datos espaciales que podrdn ser
procesados por medio de uno o mds softwares especializados. La importancia del manejo de los
datos de este modo es evitar: la redundancia en los datos, el pobre confrol de los datos y una
inadecuada manipulacién de los datos.

° Cartografia bdasica vectorial: Producto de precision obtenido a partir de procesos de fotogrametria
andlitica o digital, donde se muestran los rasgos naturales y topogrdficos de la superficie terrestre
por medio de simbolos, lineas y poligonos

°  DIVIPOLA: Cédigo de la division Politico-Administrativa del pais.

° Filegeodatas: Nombre definido para la carpeta de almacenamiento dentro del File Shares de Azure
Storage, alli se localizan las bases de datos vectoriales a publicar.

° Geoservicio: servicio web especifico que devuelve la informacion geogrdfica situada a los
servidores de los organismos productores, de una forma estédndar y a través de cualquier aplicacién
compatible. Para la generacion vy utilizacién de los geoservicios se utilizan los lenguaijes y protocolos
estdndares, definidos por el Open Geospatial Consortium (OGC).

° Label: En cartografia, texto colocado en o cerca de una entidad geogrdfica de mapa, el cual la
describe o identifica.

°  Metadato: Datos acerca de los datos geogrdficos. De manera general, son datos que describen,
en una estructura estdndar, el contenido, la calidad y otras caracteristicas de un recurso (productos
y/o servicios), convirtiéndose en un mecanismo clave para localizar, acceder y usar la informacion.

° Open Geospatial Consortium (OGC): Organizacién internacional de membresia que apoya a una
diversa comunidad de empresas, agencias gubernamentales, organizaciones de investigacién y
universidades, todas trabajando juntas para hacer que la informaciéon sobre localizacién sea FAIR:
Enconftrable, Accesible, Interoperable y Reutilizable.

° Sifigacarcgis: Nombre definido para el contenedor File Shares dentro del Azure Storage.

°  Vectorial: Modelo de datos basado en coordenadas que representa las entidades geogrdficas
como puntos, lineas y poligonos. Cada entidad de puntos se representa como un par de
coordenadas simple, mientras que las entidades de linea y de poligonos se representan como listas
ordenadas de vértices. Los atributos se asocian a cada entidad de vector, en contraposicién al
modelo de datos rdster que asocia los atributos a las celdas de la cuadricula.

°  WFS: Hace referencia a Web Feature service Servicio estdndar que ofrece un interfaz de
comunicacion que permite interactuar con los mapas servidos mediante WMS. Presenta
propiedades de edicién, andlisis y descarga.

°  WMS: Hace referencia a Web Map Service, un geoservicio que entrega imdgenes de mapas
georreferenciados a través de internet, el cual puede tener un descriptor de estilo de capa (SLD)
para especificar su simbologia y representacion.
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4. DESARROLLO

El proceso de publicacién en los servidores de mapas es llevado a cabo por diferentes dependencias
del Instituto Geogrdfico Agustin Codazzi, a continuacidn, se describe el procedimiento para generar la
publicacion.

4.1 PREPARACION DE LA INFORMACION

La informacién que se desea publicar debe estar almacenada en una base de datos espacial en
formato. gdb, estructurada segun las preferencias o modelos de datos definidos y en el sistema de
referencia MAGNA-SIRGAS / Origen-Nacional.

Se recomienda que se encuentre organizada dentro de carpetas con nombres estandarizados, en
donde adicionalmente se puedan almacenar archivos de descarga y el Metadato. En la ilustracion 1
se observa un ejemplo de organizacién de carpetas y nombres de bases de datos vectoriales de
cartografia escala 1:2.000 del municipio Corrales, Boyacd (DIVIPOLA 15215) con fecha de elaboracion
17/06/2020.

llustracién 1. Eiemplo de organizacion

Nombre

Carto2000_15215_RS_20200617.gdb
Carto2000_Limite_15215_RS_20200617
¢ Carto2000_15215_RS_20200617_gdb
¢ Carto2000_15215_RS_20200617_gpkg
¢ Carto2000_15215_RS_20200617_shp
@ Carto2000_Ficha_Tecnica_15215_RS_20200617

Fuente: IGAC, (2024)

El Instituto cuenta con dos cuentas de Portal for ArcGIS para realizar la publicacion, estas son: mapas
(https://mapas.igac.gov.co/portal) y mapas2 (https:.//mapas2.igac.gov.co/portal) y con ello dos tipos
de cargue de los datos respectivamente, el primero es en el entorno de la nube mediante el software
Microsoft Azure Storage y, el segundo en el entorno on-premise desde la NETAPP del Instituto en la
carpeta cemdatos -> Vector -> Cartografia. A continuacién, se describen los dos procedimientos del
cargue.

4.1.1 CARGUE DE LA INFORMACION A MICROSOFT AZURE STORAGE EXPLORER

Si se va a realizar la publicacién en mapas (hitps://mapas.igac.gov.co/portal), se realiza el cargue de
la base de datos espacial a Microsoft Azure Storage Explorer, el contenedor en donde se sube la
informacion se llama stfigacarcgis y dentro de él en los File Shares se dispone la carpeta trabajoigac,
alli se encuentran cada una de las carpetas definidas para el cargue de informacién de acuerdo con
el grupo de trabagjo.

La ilustracion 2 presenta el lugar de almacenamiento en donde se organiza la informacién vectorial.
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llustracién 2. Carpeta frabajo IGAC Azure Storage
& trabajoigac m %

* B T T = |

Collapse All Refresh All Upload Download Open  New Folder Select Al Copy Clone Connect VM

VIGENTE DESDE:
07/10/2024

=% Quick Access

4 &P Local & Attached == v Current ¥ trabajoigac
4 = Storage Accounts
b = (Attached Containers) fHame
3 ulator - Default Ports) (Key) Agrologia
4 = stfigacarcgis (Key) ArcGIs Pro
» [® Blob Containers Backupesri
4 [ File Shares Catastro
B files CIAF
) ccioeiae Defaultgdb

b W Queues
» [ Tables

FGDB_Publicacion

Filegeodatas
b & Cosmos DB Accounts (Deprecated)
) OptRasters
» 3 Data Lake Storage Gen1 (Preview)
PublicacionCeM
sof

Showing 1to 13 of 13 cached items

Actions Properties © Activities

URL https://stfigacarcgis.file corewindows  Clear completed  Clear successfu
Type File Share

Last Modified Tue, 21 Dec 2021 21:05:22 GMT

Quota 3000 GB

Usage 2041 GB

Fuente: IGAC, (2024)

4.1.2 CARGUE DE LA INFORMACION A CEM_DATOS

Si se va a redlizar la publicacién en mapas2 (https://mapas2.igac.gov.co/portal), se debe realizar el
copiado de la base de datos espacial a la carpeta \\172.26.0.20\cemdatos\Vector\Cartografia,
dentro de la subcarpeta respectiva segin la temdtica. Por ejempilo, si se va a publicar un producto de
bases de datos vectoriales de cartografia, deberd almacenarse en la subcarpeta “Carto”, como se
muestra en la ilustracion 3.

llustracién 3. Carpeta y subcarpetas de cemdatos

&« ™ (&) ) > Red » 17226020 > cemdatos > Vector > Cartografia > Carto >
® Nuevo Tl Ordenar = Ver
A Inicio Nombre Fecha de modificacion Tipo Tamafio
R Carto1000_05380_20230223.gdb 3/07/2024 11:49 a. m. Carpeta de archivos
) Galeria

Carto1000_05021000_20221117.gdb 4 6:58 p. m. Carpeta de archivos

> @ Daniela, IGAC
Carto1000_05031000_20230226.gdb

Carpeta de archivos

Carto1000_03036000_20230110.gdb 4 10:35 a. m.

Carpeta de archivos

W Escritorio Carto1000_05040000_20230226.gdb 43a.m, Carpeta de archivos

- Descargas Carto1000_05044000_20230129.gdb 28/05/2024 11:31 a. m. Carpeta de archivos

Fuente: IGAC, (2024)

4.2 CREACION DEL PROYECTO EN ARCGIS PRO

Se recomienda la creacion de un proyecto en ArcGIS Pro para cada servicio que se desee publicar,
ordenando los proyectos en una carpeta que sea de acceso compartido para los usuarios y que pueda
facilitar la actualizacién de los servicios y el facil acceso a la informacién origen de estos.
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4.2.1 CREACION DEL PROYECTO EN ARCGIS PRO SI SE PUBLICA DESDE EL PORTAL MAPAS
(https://mapas.igac.gov.co/portal)
Para este caso el proyecto se debe almacenar directamente en las mdaquinas de produccién de Azure.
Una vez creado, se debe readlizar la conexién a la carpeta de Microsoft Azure Storage Explorer donde
se encuentra la informacidn, en este caso es trabajoigac, siguiendo estos pasos:

a) En el panel Catalog se despliega la pestana Favorites --> Add Item ---> Add Folder

b) Se copia la ruta de frabajoigac en el buscador
\\stfigacarcgis.file.core.windows.net\trabajoigac, se hace la conexién a la carpeta deseada
para la Direccién de Gestidn de Informacion Geogrdfica la carpeta se denomina Filegeodatas
como se observa en la ilustracion 4.

llustracién 4. Carpeta destinada para la Direccidn de Gestion de Informacién Geogrdfica

Project  Map  Inset  Analysis  View  Edit  Imagery  Share  Help
Cut o (Tl : OB = = addemphistayer | ([ [y [F E awibues
y -()- L
N &, M o | ag - )
Paste  OP Explore 7~ > Baokmarks Go | Basemap Add Select Select By Select By
© [ElCopyPath | ¥ v ToxY v Datav " Attributes Location
Clipboard Navigi . 5loA
2 Add Folder Connection X
Contents v X A Catalo v X
@ @[E v Computer v trabojoigac v = [©][1=] search N ) ngp o comter Favori =
corch Organize v New ltem v l roject Portal Computer Favorites X =
=5 P 0T L g Name Type -~ Addhem v
— = Agrol Folder
Drving G =R Arc Folder
4[] Map * Backupesri Folder
(7] World Topographic Map & mhispC Catastro Folder
[¥) World Hillshade & Daniela Marin Lopez [ Folder
" Libraries FGDE. Publicacion Folder
o Network Filegeodatas Folder
Favorites OptRasters Folder
PublicacionCeM Folder
sof Folder
Name [ Filegeodatas | [Folders -
ECUADOR
 Guayaquil
[P | Amazon Basin (=]
BBz 493662849"W 4.7431609°N v Il |2 [Catal. [Sym. Jobs. Label. Locate Geop.. Attn
Fuente: IGAC, (2024)
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c) c) Se conecta al proyecto en donde se deben cargar las capas que se quieren agregar al
mapa. llustracion 5

llustracién 5. Cargue de capas

[ER=N-7] v v v v Untitled | £ d Search (Ait+Q daniela.marin - ArcGIS Enterprise Mapas de Colombia © L1 - X
Project  Map  Insert  Analysis  View  Edt  Imagery  Share  Help

';0 II | \:% = & Add Graphics Layer [\\j [E‘E [IL‘ [E9 Attributes A ﬁa r% &) Pause £ Lock ‘L:‘j r'—‘>

o H 3 2 leat o 2 &% View Unplaced :

cre [ Copy Explore 7 ¥ Bookmarks Go | Basemap Add Select SelectBy SelectBy - ' Measure Locate Infographics Coordinate Convert | Download
. < Toxy 5 o S : 3

" 9 CopyPath Attributes Location Conversion | (@ More «
Clipboard Navigate ] Layer selection ] Inquiry Labeling 5 ofine & A
Contents v ¢ x [Elmep X ~ | Catalog vrx
s =
T [Seorch p - s/ . Project Portal Computer Favorites =
S — o 50 i ortc
I S mie Cartagena " 3 Caracas s
- 0STA RICA 3 a Addtem v
= & & Spnjost o valerkia
= ; 5 MapasColombialmagenesAzure.acs
Drawing Order Panama City v =
o €} RasterCartografia.sde
4[E Map R r [ Fiteaendatac
World Topographic Map _Bucaramanga VENEZUELA + Add To Project
Vorld Hillshade | Medelin i  AddToNew Projects Add To Project
[ 5 = Add a favorite item to the current
N I A Remoye From Favorites project. The project saves a reference
Y’ B roois to the existing item.
A New
W 4 Guian,
F(ah}f J > Refresh
1y COLOMBIA
(14 B Copy CtrlsC
)
& CopyPath Ctri+AltsP
¥
)
- Quito M Delete Ctrl+D
1 ]} Rename
ECUADOR »
i Show In File Explorer
4 [E) View Metadata
( Amazon Bas /' EditMetadata
[ 113408707 -] B B T tmy v 60.6800559°W 2.1347810°5 v I |2 |cCatol.. [Sym.. Jobs.. Label.. Locate Geop.. Attri.

954 AM
A By [

Fuente: IGAC, (2024)

4.2.2 CREACION DEL PROYECTO EN ARCGIS PRO SI SE PUBLICA DESDE EL PORTAL MAPAS2

(https://mapas2.igac.gov.co/portal)

Para este caso el proyecto se debe aimacenar en la subcarpeta correspondiente segun la temdtica
como se menciona en el numeral 4.1.2, dentro de la carpeta Proyectos. Por ejemplo, para la creacion
de un proyecto de bases de datos vectoriales de cartografia la ruta seria cemdatos -> Vector ->
Cartografia -> Carto -> Proyectos, como se muestra en la ilustracién 6.

llustracién 6. Carpeta de almacenamiento de proyectos en cemdatos.

£ ™ C D > Red » 17226020 > cemdatos > Vector > Cartografia > Carto > Proyectos >
@ Nueve Tl Ordenar = Ver
A Inicio Nombre Fecha de medificacién Tipo Tamafic
Carto1000_05380_La_Estrella 27/06/2024 9:35 3. m. Carpeta de archivos
_HJ Galeria - -7 P

Carpeta de archivos

Il

Carto1000_05021000_Alejandria
> % Daniela, IGAC

Carpeta de archivos

Il

Carto1000_05031000_Amalfi

Il

Carto1000_05031000_Interseccion 06/2024 1:38 p. m. Carpeta de archivos

Il

W Escritorio Carto000_05036000_Angelopolis 16/07/20249:14 3. m.  Carpeta de archivos

Fuente: IGAC, (2024)
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De la misma forma que en numeral anterior, se realiza la conexidon desde ArcGIS Pro a la carpeta donde
se encuentra la informacién, siguiendo estos pasos:

a. En el panel Catalog se despliega la pestana Favorites --> Add Item ---> Add Folder
Se copia la ruta de cemdatos en el buscador \\172.26.0.20\cemdatos\Vector\Cartografia y
se hace la conexidon a la carpeta deseada.

4.3 CONFIGURACION DEL PROYECTO EN ARCGIS PRO

La configuraciéon y diseno del mapa depende del objetivo, creatividad y gusto del publicador; se
recomienda el uso de escalas de visualizacion para evitar que el mapa se vea denso vy la informacidn
vaya apareciendo por niveles; el uso de labels o efiquetas con fuentes apropiadas para el usuario y
paletas de colores que sean agradables para todo tipo de publico (la pdgina https://colorbrewer2.org/
es una buena fuente para obtener combinaciones de colores para mapas).

Adicionalmente se requiere agregar informacion bdsica de los datos en el metadato (ilustraciéon 7),
para esto en la tabla de contenido sobre el Mapa se da clic derecho al botén del mouse para
desplegar las propiedades - metadata.

Se debe verificar en la informacion del Metadato:

° Que el titulo sea explicativo y preferiblemente que siga el esquema de organizacién que se viene
frabajando.

° Diligenciar palabras claves.
° Diligenciar resumen y descripcion.

° Diligenciar en los créditos la enfidad que genera los datos, en caso de ser el IGAC; se recomienda el
uso del siguiente texto: Instituto Geogrdafico Agustin Codazzi - IGAC.

° Adicionalmente se recomienda cambiar el nombre Map en la pestana general por el nombre de los
datos puede ser el mismo titulo que se asignd en el Metadato.

En este punto se reitera la importancia de que los datos se encuentren en con el Ultimo prj del Origen
Nacional denominado “MAGNA-SIRGAS / Origen-Nacional" con EPSG 9377.

llustracién 7. Despliegue del metadato

Fuente: IGAC, (2024)
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Una vez configurada la informacién del metadato, verificado el sistema de referencia de los datos y
definidas las caracteristicas visuales deseadas se realiza la publicacion.

4.4 PUBLICACION DEL SERVICIO

Para la publicacion de cualquier servicio se debe tener usuario de acceso a cada Portal, ya sea mapas
(https://mapas.igac.gov.co/portal/) o mapas2 (https://mapas?2.igac.gov.co/portal/), en caso de no
contar con el usuario se debe redlizar la solicitud a la Direccién de Tecnologias de la Informacién y
Telecomunicaciones mediante incidencia por GLPI.

Es importante aclarar que Unicamente se pueden sobrescribir aquellos servicios generados por su
usuario en caso de que se vaya a publicar un servicio nuevo o Overwrite Web Layer o querer
actualizarlo.

Una vez se tenga el acceso se debe realizar el siguiente proceso:

a. Enelmenu de ArcGIS Pro se accede a Share ---> Web Layer -> Publish Web Layer

b. Lailustracién 8 muestra la configuracion de la publicacion, si se realizd el diligenciamiento del
metadato la mayoria de la informaciéon necesaria se autocompleta. Se recomienda que el
nombre del servicio (campo “Name”) sea todo en minuUscula sin espacios ni caracteres
especiales. De no ser posible, entonces que siga el esquema de organizacion que han definido.
Normalmente, en el item “Data and Layer Type" Unicamente debe quedar activada la opcidn
Map image determinada por defecto, las demds no se deben activar, a menos que se quiera
publicar un Feature service. Es importante recalcar que siempre se debe usar la opcidn
Reference reqgistered data, nunca se deben copiar los datos al servidor.

llustracién 8. configuracién de la publicaciéon

<
=
x
B
2
8
%
g
g
5
&
5
g
4
5
<

Share As Web Layer ?2v 0 X
Sharing Carto1000_13647000_San_Estanisiao As...

General Configuration Content

Item Details
Drawing Order

4{[7] Carto1000_13647000_San... | *

Nombre_Geografico

Name

carto 13647000

Summary
. Z - La cartografia basica escala 1:1.000 del municipio  ~
(7} Nombre Geografico U = L = A i San Estanislao (Bolivar), elaborada en el afio 2022

{ por el Instituto Geoarafico Aqustin Codazzi (IGAC),

Tags

Marco_referencia_terres.. - Cartografia X San Estanislao X
2 & ) CabéceraMinicipal de 9
Puente_L San-Estanislas d& Kostka Bolivar X || Colombia X

| Curva_Nivel Data and Layer Type ©
.
2 Reference registered data

Limite_Via ® Map Image

Cerca : - - Feature

Muro Vector Tile
Drenaje L
Construccion_R Finish Sharing

Zona_Dura

[ analyze ][ & publish ][ Eobs |

= Cat. |Sha. [Sy.

) Drenaje R

Denasitn Aaua R 1:18,056 - || B B ER ANy 75.1641142°W 10.3919158°N v n Job.. Lab.. Loc.. Geo.. Aftr.

Fuente: IGAC, (2024)

En el item Location se deben definir las carpetas de ubicacion en el servidor esto con el fin de
conservar el orden en el mismo. Se recomienda que estas carpetas se nombren sin espacios ni
caracteres especiales y en minUscula, el campo “Portal Folder” hace referencia a las carpetas
creadas para su usuario y los campos “Server and Folder” al servidor donde se publicard la
informacion y el folder donde se dispondrd, en caso de necesitar una carpeta diferente a las
ya creadas puede agregar una nueva. Para el caso de los servicios vectoriales el Sever
seleccionado siempre corresponde al Hosting Server.

Una vez seleccionados los Folder de salida de la informacién en el item “Share with"” se activa
el campo Everyone si quiere compartir el servicio con todo el publico (llustracién 9).
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llustracién 9. Activacién Share with

Share As Web Layer 7 v REX
Sharing Carto1000_13647000_San_Estanislao As...

General Configuration Content
) reature

) Tile

) Map Image

) Vector Tile

+| Feature )
Location

Portal Felder

‘ carto '|

Server and Folder

‘https:_fa'mapas.igac.gov.(m’sawer (Hosting Serv v| )

‘ carto -

Share with
[+ Everyone
[| ArcGIS Enterprise Mapas de Colombia

Groups v

Finish Sharing

| v Analyze H O3 Publish  ~ H [l Jobs |

Fuente: IGAC, (2024)
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f. Adicionalmente se deben readlizar las configuraciones de capacidades disponibles, en la
pestana “Configuration” en Configure layer se activa preferiblemente las capacidades WMS y

WEFS. llustracion 10.

P&gina 8 | 12

lustracién 10. Activaciéon capacidades

Share As Web Layer 7 v X
Sharing Carto1000_13647000_San_Estanislac As...

General Configuration Content

EL
Layer(s)

E Map Image
Additional Layers
v B wwms
[ 1@ wrg

Capabilities

[ Bwcs

[ & kmL

Finish Sharing

Fuente: IGAC, (2024)
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g. Luego en la misma pestaina de “Configuration” en Configure Pooling seleccione la opcién
“Dedicated Instace” y como instancias minimas coloque el valor 0 y mdximas el valor 2.
llustracion 11.

llustracién 11. Activaciéon de instancias

Share As Web Layer v X
Sharing Carto1000_13647000_San_Estanislac As...

General Configuration Content

Eln

v Instance Type @

® Dedicated instance

) Shared instance

~ Mumber of instances per machine €

Minirurm
Maximum
Fuente: IGAC, (2024)
h. Analizar y publicar.
5. CONTROL DE CAMBIOS
FECHA CAMBIO VERSION

° Hace parte del proceso de Gestion de Informaciéon Geogrdfica para el SAT, del subproceso de
Gestion Cartogrdfica.

°  Se actudliza el instructivo "Creacidn y Publicacién de Servicios Web Geogrdficos - Vectorial”,
cédigo IN-CAR-PC02-02, versidn 1, a instructivo del mismo nombre, céddigo IN-CAR-PC02-02,

07/10/2024 version 2. , . o L - 2

° Se encuentra asociado al procedimiento Disposicion de la Informacion Geogrdfica.

° Se agjusta documento a la nueva cadena de valor del IGAC.

°  Se actualiza plantilla vigencia 2024.

° Se actualizan imdgenes y enlaces de acceso a repositorios.

° Se crea el capitulo de definiciones.

° Se adopta como versidn 1 por corresponder a la creacién del documento. Emision Inicial Oficial.

°  Hace Parte del proceso Gestiéon de Informacién Geogrdfica, subproceso Gestién Cartogrdfica.

20/12/2021 | © Se encuentra asociado al procedimiento Disposicion de la Informacion Geogrdfica. 1

°  Secrea elinstructivo “Creacion y Publicacion de Servicios Web Geogrdficos - Vectorial”, cédigo
IN-CAR-PC02-02, version 1.

REVISO

ELABORO Y/O ACTUALIZO REVISO TECNICAMENTE METODOLOGICAMENTE APROBO
Nombre: Nombre: Nombre: Nombre:
Equipo del subproceso | Victor Andrés Martinez Ruiz. Karen Andrea Pastrana Pérez. | Carlos Andrés Franco Prieto.
Gestion Cartogrdfica.
Cargo: Cargo: Cargo:
Cargo: Confrafista. Confrafista. Subdirector.
Subdirecciéon Cartogrdfica y | Direccion De Gestién De | Oficina Asesora de | Subdireccién de Cartografia
Geodésica. Informacién Geogrdfica. Planeacién. y Geodesia.
Nombre:

Elkin Josué Géngora Leal.
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Instructivo Creacidn y Publicacion de Servicios WEB Geogrdficos - Vectorial

cODIGO VERSION: VIGENTE DESDE:
IN-CAR-PC02-02 2 07/10/2024

REVISO
METODOLOGICAMENTE

ELABORO Y/O ACTUALIZO REVISO TECNICAMENTE

APROBO

Cargo:

Profesional especializado.
Direccién de Gestion de
Informacion Geogrdfica.

Nombre:

Yeimy Ledesma Gémez.
Cargo:

Contratfista.

Direccién de Gestion de
Informacion Geogrdfica .
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